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Adobe Flash Interview Questions And Answers Guide.

Question - 1:
Which of the following is NOT a true statement about the Print action?

Ans:
A. It provides quality vector-based prints
B. It prints all frames ofthe target timeline unless otherwise specified
C. It is CPU intensive
D. It doesn't print alpha channels
View All Answers

Question - 2:
Which of hte following methods provedes the most controlled printing of Flash content?

Ans:
A. The Flash Player Contextual Menu
B. The print action
C. The ExportToprinter action
D. The browser file menu
View All Answers

Question - 3:
You have a TextField selected on stage and would like to separate each letter into its own TextField. Which option under the Modify menu allows you to do this?

Ans:
A. Divide
B. Separate
C. Break Apart
D. Individualize
View All Answers

Question - 4:
Which of the following properties can be used to control the order in which the user can tab through the elements in a Flash movie?

Ans:
A. tabOrder
B. tabNumber
C. tabValue
D. tabIndex
View All Answers

Question - 5:
Which of the following items cannot be hidden from screen readers?

Ans:
A. Static text
B. Dynamic text
C. Buttons
D. Movie clips
View All Answers

Question - 6:
When does the Accessibility . isActive () method return true?

Copyright © https://InterviewQuestionsAnswers.org Page 3/23

https://interviewquestionsanswers.org/
https://interviewquestionsanswers.org/_Adobe-Flash
https://interviewquestionsanswers.org/__Which-of-the-following-is-NOT-a-true-statement-about-the-Print-action
https://interviewquestionsanswers.org/__Which-of-hte-following-methods-provedes-the-most-controlled-printing-of-Flash-content
https://interviewquestionsanswers.org/__You-have-a-TextField-selected-on-stage-and-would-like-to-separate-each-letter-into-its-own-TextField
https://interviewquestionsanswers.org/__Which-of-the-following-properties-can-be-used-to-control-the-order-in-which-the-user-can-tab-through
https://interviewquestionsanswers.org/__Which-of-the-following-items-cannot-be-hidden-from-screen-readers
https://interviewquestionsanswers.org/


Adobe Flash Interview Questions And Answers

Interview Questions Answers.ORG

Ans:
A. When the current Flash movie is in an MSAA-compatible browser .
B. When a screen reader is detected
C. When an input device for people with disabilities is detected.
D. When Flash content has been designated as Accessible.
View All Answers

Question - 7:
What is generally considered the ideal group size for usability testing?

Ans:
A. 1-2
B. 3-5
C. 6-11
D. 11-20
View All Answers

Question - 8:
Which of the following is not a guideline for conducting effective usability testing?

Ans:
A. Avoid leading questions.
B. Provide helpful, step-by-step instructions on how each task should be completed.
C. Ask users to think aloud.
D. Take lots of notes.
View All Answers

Question - 9:
At which point can you start usability testing?

Ans:
A. Some sketches of the products interface are drawn.
B. The application goes alpha.
C. The application goes beta.
D. The application is code complete.
View All Answers

Question - 10:
Which of the following is not a key benefit of usability testing?

Ans:
A. Find out how potential customers will use your application.
B. Direct marketing exposure to test candidates.
C. Identify areas where the product is difficult to use.
D. Receive valuable comments from customers on how to improve the application.
View All Answers

Question - 11:
Which of the following is not an effective means of developing applications that are easy to debug?

Ans:
A. Separating and encapsulating each feature of your application
B. Avoiding the use of external .as files
C. Creating differnet classes for different tasks
D. Making sure your methods and classes have descriptive names
View All Answers

Question - 12:
Which of the following is not a result of exporting a movie for a debug build?

Ans:
A. A normal SWF file is created.
B. An SWD file is created in your working ddirectory.
C. The Debug window appears.
D. You can step through each breakpoint you have set in the movie.
View All Answers

Question - 13:
Which of the following cannot be automatically outputted by the trace action?

Ans:
A. String values
B. Array values
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C. Object instance values
D. Date and Time values
View All Answers

Question - 14:
Which of the following is not a typical host application for the Flash Player?

Ans:
A. A browser
B. A projector
C. A Java executable
D. A third-party wrapper
View All Answers

Question - 15:
Which of the following is the most important factor in determining the compatibility of your application?

Ans:
A. The Flash Player version installed.
B. The operating system installed.
C. The screen resolution.
D. The use of external assets.
View All Answers

Question - 16:
Which of the following assumptions cannot be made when developing an application for intranet deployment?

Ans:
A. The connection speed between computers will be generally faster than on the Internet.
B. Users will have the same version of the Flash Player.
C. The computers accessing the application will be pretty similar to each other as far as capability is concerned.
D. Users will have an Internet connection.
View All Answers

Question - 17:
Flash Remoting cannot do which of the following?

Ans:
A. Access data directly from a remotely hosted Web service.
B. Integrate seamlessly with existing Macromedia UIComponents
C. Translate SOAP XML data into native Flash objects.
D. Marshall native Java objects into Flash objects
View All Answers

Question - 18:
Which of the following external ActionScript files must you #include in your movie in order to use Flash Remoting?

Ans:
A. URLRemote . as
B. Gateway . as
C. NetServices . as
D. GetRemote . as
View All Answers

Question - 19:
Which of the following steps is not required in order to test or deploy Flash Remoting?

Ans:
A. Install and configure a supported Web server application environment.
B. Download and install the server-side remoting components
C. Download and install the Flash MX Remoting components
D. Implement a Macromedia UIComponent
View All Answers

Question - 20:
How does an XMLSocket server know when a received message is complete?

Ans:
A. The XMLSocket. onXMLLoad method is called by the client.
B. The XMLSocket . onLoad method is called by the client.
C. A zero byte is received.
D. The XMLSocket server is unable to determine when a received message is complete.
View All Answers
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Question - 21:
Which of the following is not a true statement about the XMLSocket object?

Ans:
A. It can only be used to pass XML.
B. It uses a persistent two-way socket.
C. With the XMLSocket object, once the client connects to the server, it stays connected until one side terminates the connection.
D. It can push data from the server to the client..
View All Answers

Question - 22:
Which of the following is not a true statement about HTTP?

Ans:
A. It is a one way request/response protocol.
B. Once a request is made, the server returns the requested resource.
C. With HTTP the server needs to make frequent requests to see if client data has changed.
View All Answers

Question - 23:
Which of the following is not true about the XML. ignoreWhite property?

Ans:
A. If the ignoreWhite property is true,all spaces in the XML document will be ignored.
B. Carriage returns are treated as data if the ignoreWhite property is set to false.
C. With the ignoreWhite property set to true, you can reduce the number of nodes that need to be created during parsing
D. The default value for the ignoreWhite property is true.
View All Answers

Question - 24:
What is the primary difference between the XML.sendAndLoad method and the XML.load method?

Ans:
A. The XML.sendAndLoad method has additional properties for checking an load status.
B. XML.laad loads documents slightly faster,as there is no error checking on the client side.
C. XML.sendAndLoad allows you to send specific XML data to the server
D. An entire XML document can be sent to the server using XML.sendAndLoad.
View All Answers

Question - 25:
What does the childNodes property contain?

Ans:
A. The number of child nodes for the current node.
B. The number of child nodes in the current document.
C. An array of all the child nodes for the current node.
D. A true or false value indicating whether the current node has child nodes.
View All Answers

Question - 26:
Which of the following is not true about Document Type Definitions (DTDs)?

Ans:
A. They sllow you a means of testing your XML for valid output.
B. They must be referenced when instantiating an XML object.
C. They make your XML data sources more understandable.
D. THey let you create new markup languages.
View All Answers

Question - 27:
Which of the following is the key advantage of using Loadvars instead of Loadvariables?

Ans:
A. Data can be loaded to object other than the one making the Loadvars call.
B. It can handle more variables.
C. It is supported by Flash Player 4, 5 and 6
View All Answers

Question - 28:
Where is the data pulled by a load variables function stored?

Ans:
A. The targeted array
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B. The targeted movie clip
C. The main timeline
D. Any of the above
View All Answers

Question - 29:
When should one generally use the POST method instead of the GET method?

Ans:
A. When the query string contains periods(.)
B. When the query string contains spaces()
C. When the query string is particularly long
D. When the query string has only one variable
View All Answers

Question - 30:
Which of the following is the key advantage of Flash being a true clientside application?

Ans:
A. It uses a stateless protocol.
B. It supports the use of ASP and JSP.
C. It provedes rich support of server-side session variables.
D. It can maintain its state without help from the server.
View All Answers

Question - 31:
Which keyword is used to attach methods and properties to a class?

Ans:
A. assign
B. prototype
C. inherit
D. declare
View All Answers

Question - 32:
Which statement best describes what the #initclip num and #endinitclip commands indicate?

Ans:
A. Ablock of component initialization actions
B. A list of methods associated with an object
C. A block of classes to be inherited from
D.A list of initial property values
View All Answers

Question - 33:
Which of the following lines of code will create an object instance of the organism class?

Ans:
A. Organism = new Class();
B. Organism = new Function();
C. Create new Class(Organism);
D. Organism = new Organism();
View All Answers

Question - 34:
Which statement best describes a property:

Ans:
A. A variable assigned to a method.
B. A variable assigned to an object instance.
C. An object's type.
View All Answers

Question - 35:
Which of the following is NOT a good idea when working with methods:

Ans:
A. Try to minimize the amount of tasks an individual method provides.
B. Use methods as an interface for use by other objects.
C. Only write one method per object.
View All Answers
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Question - 36:
Which of the following statements is true about ActionScript in regards to the enforcement of private scope and public scope?

Ans:
A. It is strongly typed.
B. You can manually set the scope of methods and properties as either private or public.
C. Methods of public scope are only accessible outside the object.
D. There is no enforcement of the private and public scope with ActionScript.
View All Answers

Question - 37:
Which of the following method is best for removing an object(e.g.,myObj) from memory?

Ans:
A. myObj =0;
B. remove myObj;
C. delete myObj;
D. myObj = null Object()
View All Answers

Question - 38:
Which of the following lines of code will create a new object named myObj?

Ans:
A. myObj = Object();
B. myObj = new Object();
C. new Object.myObj();
D. new Object(myObj);
View All Answers

Question - 39:
For methods within objects,what does the keyword this specifically refer to?

Ans:
A. The object itself
B. The method
C. The movie clip containing the object
D. The root timeline
View All Answers

Question - 40:
The class that is inheritingt another is known as the:

Ans:
A. child class
B. super class
C. sub class
D. base class
View All Answers

Question - 41:
What will be the result of the following line of ActionScript?

Ans:
Code: 
    print(_root.myClip,"bmax");
A. The myClip and "bmax" movie clips will be printed.
B. A bounding box will be created by the location of the myClip and "bmax" movie clips,and this area will be printed.
C. The myClip movie clip will be printed, and each frame will be scaled to fill the maximum space on the printed page.
D. The largest printable frame in the myClip will be used to determine the bounding box for all frames printed.
View All Answers

Question - 42:
Which of the following is the correct way to create an alert box using getURL and JavaScript?

Ans:
A. getURL = function ("javascript:alert("Hello World"));
B. getURL(alert,"Hello World:");
C. getURL(javascript (alert,'Hello World'););
D. getURL("javascript:alert('Hello World:');");
View All Answers

Question - 43:

Copyright © https://InterviewQuestionsAnswers.org Page 8/23

https://interviewquestionsanswers.org/
https://interviewquestionsanswers.org/_Adobe-Flash
https://interviewquestionsanswers.org/__Which-of-the-following-statements-is-true-about-ActionScript-in-regards-to-the-enforcement-of-privat
https://interviewquestionsanswers.org/__Which-of-the-following-method-is-best-for-removing-an-objectegmyObj-from-memory
https://interviewquestionsanswers.org/__Which-of-the-following-lines-of-code-will-create-a-new-object-named-myObj
https://interviewquestionsanswers.org/__For-methods-within-objectswhat-does-the-keyword-this-specifically-refer-to
https://interviewquestionsanswers.org/__The-class-that-is-inheritingt-another-is-known-as-the
https://interviewquestionsanswers.org/__What-will-be-the-result-of-the-following-line-of-ActionScript
https://interviewquestionsanswers.org/__Which-of-the-following-is-the-correct-way-to-create-an-alert-box-using-getURL-and-JavaScript
https://interviewquestionsanswers.org/


Adobe Flash Interview Questions And Answers

Interview Questions Answers.ORG

Which of the following is the best reason for using the getURL command, instead of the fscommand, when communicating with the host application?

Ans:
A. getURL can receive return values from the host application.
B. You do not have to use JavaScript to interact with the host application.
C. It is supported by the Flash Player 6.
D. It is compatible with more browsers.
View All Answers

Question - 44:
Which of the following is NOT a disadvantage of using the fscommand?

Ans:
A. Your movie becomes tied to a particular host application.
B. You can only have one fscommand in your movie.
C. Its use is not supported by Netscape 6.
D. The host application will not be able to return values to yur fscommand call.
View All Answers

Question - 45:
Which of the following is NOT a benefit of using Macromedias pre-built UI components:

Ans:
A. Possible time savings by using pre-written code.
B. Good code examples to learn from.
C. Macromedia UI components stream int the Flash Player over the duration of the main movie timeline.
D. Simple color and font changes are easier to make.
View All Answers

Question - 46:
Which ActionScript method should be used to bring a component from the library to the stage?

Ans:
A. attachMovie
B. addComponent
C. insertMovie
D. openComponent
View All Answers

Question - 47:
What is the downside of Macromedia UI components making extensive use of ingeritance and encapsulation?

Ans:
A. Global variables cannot be used.
B. Increased file size for first UI component added.
C. UI components cannot be modified.
D. .swf files cannot be loaded at runtime.
View All Answers

Question - 48:
Which of the following is a true statement about custom event handlers?

Ans:
A. Their use should be avoided .
B. They can cause handler conflicts with native ActionScript classes.
C. They can inherit from existing ActionScript classe.
D. They are not supported by the Flash 5 Player.
View All Answers

Question - 49:
Which of the following methods is most likely an event handler?

Ans:
A. MouseDown()
B. _mouseDown
C. MouseDown
D. onMouseDown
View All Answers

Question - 50:
Which of the following statements best describes an event handler?

Ans:
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A. A single central script that handles all of the events that take place and determines the appropriate action to take
B. A security function in the root of the timeline that controls access to events
C. A means of allowing an object to notify your scripts of a change of state
View All Answers

Question - 51:
Which of the following methods can be used to determine if a microphone or a camera is installed on the users machine?

Ans:
A. System.richmedia.
B. System.accessories
C. System.capabilities
D. System.peripherals
View All Answers

Question - 52:
Which of the following is not true about FLV files?

Ans:
A. They contain video with all the compression selections already applied.
B. They are not comatible with Macintosh OS 9;
C. They con be imported into other movies without a significant delay.
D. When imported,they are treated the same as other imported video files.
View All Answers

Question - 53:
In general, ,non-MP3 digital audio destined to be imported into the Flash MX authoring environment should first be compressed how much?

Ans:
A. 0%(largest file size)
B. 50%(medium file size)
C. 75%(smaller file size)
D. As much as possible (smallest file size)
View All Answers

Question - 54:
What is the primary purpose of the stage object?

Ans:
A. To size the flash movie
B. To layer objects on the stage
C. To position objects on the stage
D. To load objects on the stage
View All Answers

Question - 55:
Which of the following is not true about Capabilities object?

Ans:
A. Its a property of the system object
B. It is intended primarily for the development of content intended for person with disabilities
C. It provied access to information about the user's machine
D. It does't need to be instantiated to be used.
View All Answers

Question - 56:
In which of the following situations would it be best to use the Coordinated Universal time (UTC) when using a Date object?

Ans:
A. When calculating elapsed time on the users machine
B. When communication with a server in an unknown geographical area
C. When accuracy to the millisecond is needed
D. When converting dates to string
View All Answers

Question - 57:
Tell the difference between indexed array and associative array?

Ans:
A. Associative array can have values of any type, whereas indexed arrays contain only numbers.
B. Indexed array contain only one type of data, where associative array can have multiple type of data.
C. Associative array contain values indexed by integers, whereas assosiative arrays contain values indexed by string.
D. Associative array contain value pairs, whereas indexed array contain single values.
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Question - 58:
What best describes what is happening to the new object being created in the following line of code?

Ans:
Code:
    Mexico.prototype = new Country();
A. All of its properties and methods will be passed to the country object.
B. All of the country object's properties and methods will be available to the Mexico object.
C. Both A and B.
D None of the above.
View All Answers

Question - 59:
Whitch of the following of code will return "Video" from the following code block?

Ans:
Code:
    aThing = new Object();
    aThing.mediatype = "Video";
    aThing.format = "DVD";
    aThing.getMediaType = function(){
    return this.mediatype;
    }
A. aThing.getMediaType
B. aThing.getMediaType();
C. aThing.getMediaType{};
D. aThing(getMediaType);
View All Answers

Question - 60:
What is the key problem with the following line of code?

Ans:
Code: 
    aThing = {type:"Monster", teeth:250, bloodtype:K, getName:function(){return this.bloodtype;}}; 
A. It will return an error.
B. .It wastes memory
C. The object will go out of scope as soon as it executes
D. The syntax will become difficult to read as additional complexity is added.
View All Answers

Question - 61:
Which is NOT a benefit when adding a title in the Document Properties?

Ans:
A. The title will be used for your HTML document
B. Metadata will be added for any version of Flash
C. Metadata will be added to the head of the SWF file
D. Metadata can be seen by choosing Publish Settings >Generate Size Report
View All Answers

Question - 62:
You have a video project that would best be served by using full screen mode. This needs to be done from within the browser, since you are NOT able to use a
projector. Which publish settings should you use?

Ans:
A. Use Flash Player 7 or higher.
B. Use Flash Player 8 or higher.
C. Use Flash Player 9 or higher.
D. None. FullScreen mode is only possible in a projector.
View All Answers

Question - 63:
Your company logo is available in the following formats: Illustrator, JPG, PNG, GIF and
PSD. Which format would give you the most options within your Flash project?

Ans:
A. GIF
B. JPG
C. PNG
D. PSD
E. Illustrator
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Question - 64:
User accessibility on your video project is a key factor. Which two features should you
choose? (Choose two)?

Ans:
A. Set showCaptions = true.
B. Use methods of the AccessibleVideo class.
C. Use methods of the UserAccessiblility class.
D. Use Flash 8 Player and the useCaptions method.
E. Use Flash Player 9 with FLVPlayBackCaptioning component.
View All Answers

Question - 65:
You are creating a project for the FlashLite player. You are concerned with the processor
capabilities of the device. Which graphic asset would require the most processing power on the player?

Ans:
A. GIF
B. JPG
C. PNG
D. Vector
View All Answers

Question - 66:
Which is an advantage of selecting a Flash Player version in Publish Settings before
beginning a project?

Ans:
A. There is NO advantage. It is identical to choosing them at the conclusion.
B. Components not available in the targeted player will be removed from the Components
Panel.
C. Classes, Properties, Methods and Events NOT available in the targeted player will be
highlighted in the Script Navigator.
D. Classes, Properties, Methods and Events NOT available in the targeted player will be
removed from the Script Navigator.
View All Answers

Question - 67:
Which text anti-aliasing property setting will result in the smallest SWF file size?

Ans:
A. Use Device Fonts
B. Anti-Alias for Animation
C. Anti-Alias for Readability
D. Bitmap Text (No Anti-Alias)
View All Answers

Question - 68:
You have a dynamically loaded image that is larger than your stage. Which component
would work best to accommodate this image?

Ans:
A. Window
B. TextArea
C. DataGrid
D. ScrollPane
View All Answers

Question - 69:
You want to create a Rectangle shape with a defined corner radius. Which tool should you use?

Ans:
A. Square
B. Rectangle
C. Rectangle Primitive
D. Rectangle Shape Properties
View All Answers

Question - 70:
Which two file formats can be imported into a SWF file at runtime? (Choose two)?

Ans:
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A. AI
B. JPG
C. EPS
D. PNG
E. PSD
View All Answers

Question - 71:
What happens when you drag an object created with the Oval tool to the Library panel?

Ans:
A. The oval object is added to the Library as a symbol.
B. The oval object is added to the Library as an object.
C. The oval object is added to the Library as a primitive.
D. The oval object is added to the Library as an imported item.
View All Answers

Question - 72:
Which two are symbol options when converting an object into a symbol? (Choose two)?

Ans:
A. Video
B. Image
C. Graphic
D. MovieClip
E. Component
View All Answers

Question - 73:
You want to skin Flash CS3 components. What should you do?

Ans:
A. Edit the HaloTheme
B. Edit the SampleTheme
C. Apply one of the available themes
D. Double-Click a component on the stage and edit the internal graphic
View All Answers

Question - 74:
Which two panels can be used to change the label text of a Button component? (Choose two)?

Ans:
A. the Strings panel
B. the Properties panel
C. the Component panel
D. the Accessibility panel
E. the Component Inspector panel
View All Answers

Question - 75:
Which is the quickest way to make the stroke around an oval shape into a dotted line?

Ans:
A. Apply the Dotted filter to the stroke of the shape.
B. In the Ink Bottle tool options, set the stroke join type to dotted.
C. Set the stroke type of the shape to dotted in the Properties panel.
D. Choose the Modify > Shape > Convert Lines to Fills option and erase parts
of the stroke to make it appear dotted.
View All Answers

Question - 76:
You are creating a form that will fade out when the user submits it. What must you do to with the text fields to ensure that text entered by the user will fade out?

Ans:
A. Embed the font in the text field.
B. Use device fonts in your text field.
C. Set the text field type to dynamic.
D. Choose the Anti-alias for Animation option from the Font Rendering Method pop-up
menu in the Properties panel.
View All Answers

Question - 77:
You have a rectangle shape with rounded corners. You want to ensure that the corners do
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NOT distort when the rectangle is scaled. What should you do?

Ans:
A. Adjust xscale and yscale properties
B. Convert the shape to a Graphic symbol
C. It's not possible to prevent the corners from scaling
D. Convert the shape to a MovieClip and apply 9-slice scaling
View All Answers

Question - 78:
Which ActionScript classes are used to play FLV formatted video?

Ans:
A. FlvConnection and FlvStream
B. NetConnection and NetStream
C. ProgConnection and ProgStream
D. NetConnection and FlvConnection
View All Answers

Question - 79:
What appears in the Output window after executing this ActionScript on the first frame of a movie?

Ans:
Code:
    myVar = 20;
    _ global.myVar = 10;
    trace(myVar);
A. 10
B. 20
C. null
D. error message
View All Answers

Question - 80:
What is the output of the following code?

Ans:
Code: 
    var fruits:Array = new Array("apple", "strawberry", "orange");
    fruits.unshift("orange");
    trace(fruits);
A. apple,strawberry
B. apple,strawberry,orange
C. apple,strawberry,orange,orange
D. orange,apple,strawberry,orange
View All Answers

Question - 81:
What is the purpose of the break statement?

Ans:
A. to cause a function to stop executing immediately and not run any other
lines of code in a function
B. to cause a conditional loop to stop executing immediately and exit the loop
without running any other lines of code in the loop
C. to stop executing the code in a frame immediately and go to the next frame
without executing any other lines of code in the frame
D. to cause a conditional loop to stop executing immediately, return to the top
of the conditional loop and continue with the next pass of the loop
View All Answers

Question - 82:
Which two sets the x position of the instance my_mc to that of the mouse cursor? (Choose two)?

Ans:
A. my_mc._x=mouse._x;
B. my_mc._xmouse=this._x;
C. _root._xmouse=my_mc._x;
D. my_mc._x=_root._xmouse;
E. my_mc._x==_root._xmouse;
F. my_mc._x=Mouse.addListener(x);
G. setProperty(my_mc,_x,_root._xmouse);
View All Answers

Question - 83:
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Which two TextField events can be captured to trigger scripts to run? (Choose
two)?

Ans:
A. onChanged
B. onScrolled
C. onRelease
D. onScroller
E. onClick
View All Answers

Question - 84:
Which code should be added to create a second blue square to the right of the
first?

Ans:
A. anotherClip. _ x = 300;
myBit.draw(thisClip);
B. anotherClip.lineTo(300,100);
myBit.draw(thisClip);
C. anotherClip.moveTo(anotherClip. _ x+300,anotherClip. _ y)
myBit.draw(thisClip)
D. anotherClip. _ x = 300;
myBit.duplicateMovieClip("anotherClip", "blueSQ",
getNextHighestDepth());
View All Answers

Question - 85:
Which two statements about device fonts are true? (Choose two)?

Ans:
A. rotated text set in a device font can be rendered
B. device fonts are NOT embedded in the Flash SWF file
C. device fonts cannot be masked by using a mask layer on the Stage
D. device fonts can only be used with static horizontal text and input text
E. using device fonts results in a somewhat smaller SWF fi le then all of the other font options
View All Answers

Question - 86:
To what does object drawing model refer?

Ans:
A. drawing of regular shaped objects only
B. drawing of irregular shaped objects only
C. drawing of objects within symbol editing mode
D. drawing of objects that merge with other shapes
E. drawing of objects that cannot merge with other shapes
View All Answers

Question - 87:
Which of the following statements uses proper for loop syntax?

Ans:
A. for(i=0, i<10, i++){}
B. for(i=0 ; i<10; i++){})
C. for((i=0)),(i<10),(i++){}
D. for(i=0 i<10 i++){}
View All Answers

Question - 88:
What is the key difference between while loops and do while loops?

Ans:
A. do while loops cannot get stuck in a endless loop.
B. do while loops will always execute at leats ones.
C. while loops are deprecated in Flash MX.
View All Answers

Question - 89:
Assuming myVar equals "fish", what will be treced by the following code block?

Ans:
Code:
    switch(myVar){
    case "cat": trace("cat");
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    case "fish": trace("fish");
    case "bird": trace("cat");
    default: trace("default");
    }
A. "fish"
B. "fish"
C. "fish default"
D. "fish bird default"
View All Answers

Question - 90:
In which of the situations bellow would it be best to use a switch statement?

Ans:
A. You need to test for two possible values.
B. You want to test for many possible values
C. You want a loop to run at leats once.
D. You only want one thing to happen if a condition is true.
View All Answers

Question - 91:
Which of the following if statement is correctly writen?

Ans:
A. if firstName = "ABC" then {};
B. if {firstName = "ABC"} then ();
C. if(firstName == "ABC") {};
D. if(firstName = "ABC" || lastName="abc") {};
View All Answers

Question - 92:
Function can be assigned to identiires at runtime. Assuming sampleVar equals true, what will be returned by the following function?

Ans:
Code:
    function sampleFunction(sampleVar){
      if(sampleVar==true){
       return "true";
       return "continue";
       }
    } 
A. Nothing
B. true
C. undefined
D. continue
View All Answers

Question - 93:
Which of the following is NOT a true statement about functions?

Ans:
A. Function must specify exactly how many argument they can accept.
B. Function arguments should be comma-delimited.
C. Function name should not be start with a number.
View All Answers

Question - 94:
Which of the following is not a valid function name:

Ans:
A. get_value
B. _getValue
C. 4ever
D. $1099
View All Answers

Question - 95:
To manually dispose of the variable myVar, the following code should used to prevent memory leaks:

Ans:
A. delete myVar;
B. remove myVar;
C. myVar = null;
D. myVar = 0;
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Question - 96:
To create a new global variable, birthyear, with an initial value 1968, the following code should be used:

Ans:
A. new Global birthyear = 1968;
B. global(birthyear)=1968;
C. _global.birthyear=1968;
D. global.birthyear=1968;
View All Answers

Question - 97:
The value of a variable of timeline scope will persist until:

Ans:
A. The code block in which it was declared finishes executing.
B. The variable is removed using the clear keyword.
C. The player moves to a new scene.
D. The object to which it belongs no longer exists..3
View All Answers

Question - 98:
Which of the following is most likely a class constructor?

Ans:
A. CLASS_CONSTRUCTOR
B. ClassConstructor
C. classConstructor
D. class_constructor
View All Answers

Question - 99:
What should be inferred by a variable named birthPlace_str?

Ans:
A. It is a short-term variable and will be disposed of once its script is executed.
B. It can store multiple values
C. It is a string
D. It can hold 64 charactor
View All Answers

Question - 100:
What should be used in the name of constant?

Ans:
A. Spaces between each word in the name
B. All capital letters
C. A number before character
D. A name followed by ()
View All Answers

Question - 101:
Which of the following charactor can be added to the identifire mylengthyvariable, to make it more redable?

Ans:
A. Minus sign, "-" (e.g. my-lengthy-variable )
B. An underscore, "_" (e.g. my_lengthy_variable)
C. A period, "." (e.g. my.lengthy.variable)
D. A plus sign, (e.g. my+lengthy+variable)
View All Answers

Question - 102:
A button instance is named circle_btn. Actionscript is placed on the main timeline so that the button is clicked a movie clip instance named rec_mc s width is changed
to 100?

Ans:
A. circle_btn.onRelease = function() {this.width=100;}
B. circle_btn.onRelease = function() {rec_mc.width=100;}
C. Circle_btn.onRelease = function() {rec_mc.width=100;}
D. circle_btn.onRelease = function() {rec_mc._width=100;}
View All Answers
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Question - 103:
What is needed when using static text to have font outline embedded in SWF file?

Ans:
A. Nothing, Font outline are embedded by default.
B. Select new font in the library panel menu.
C. Select the alias button in the properties panel.
D. Select use device font form the properties panel.
View All Answers

Question - 104:
What methods are used to pass variables out of flash to a server side solution? (Choose Three)?

Ans:
A. LoadVars
B. GotoAndStop
C. getURL
D. LoadMovie
View All Answers

Question - 105:
What is the advantage of progressive video download?

Ans:
A. The frame rate of video file can be different from the frame rate of the SWF file.
B. Delivery of media is more secure than streaming video, because media does not get saved to the client cache when streamed.
C. To play the progressive download video, the entire movie must be downloaded before video will be start to play.
D. It usages less of the client memory and disk space than the streaming video download.
View All Answers

Question - 106:
Which statement concerning symbol instance statements are correct? (Choose Two)?

Ans:
A. The Hit State of a Button Symbol instance is invisible at runtime.
B. Graphic symbol instances may be directly controlled using action script.
C. If a fill color in a graphic symbol is changed, all instances of graphic symbols are changed.
D. A movie clip symbol instance may have a different frame rate than the main timeline.
View All Answers

Question - 107:
What is the function of trace?

Ans:
A. Initiate the automatic debugging procedure.
B. Discover who has downloaded your movie.
C. Send String Values to the output panel.
D. Determine what objects are presents on stage ant any one time.
View All Answers

Question - 108:
What are the correct statements consenting text field? (Choose Two)?

Ans:
A. Embedded font outlines are shared by text fields using the same font.
B. Font Outlines for static for static text field are embedded in the SWF file by default.
C. Font outline for input text field are embedded in SWF file by default.
D. Individual font outlines are embedded in to the SWF file for each text field in the FLA file.
E. Font outlines for dynamic text fields are embedded in SWF file by default.
View All Answers

Question - 109:
What happens if an .swf is loaded into a already occupied level?

Ans:
A. An error is thrown.
B. The new swf is rejected and the old one stays.
C. The old swf is unloaded and the new swf is loaded.
D. They share the same level
View All Answers

Question - 110:
In which level does the original movie resides?

Copyright © https://InterviewQuestionsAnswers.org Page 18/23

https://interviewquestionsanswers.org/
https://interviewquestionsanswers.org/_Adobe-Flash
https://interviewquestionsanswers.org/__What-is-needed-when-using-static-text-to-have-font-outline-embedded-in-SWF-file
https://interviewquestionsanswers.org/__What-methods-are-used-to-pass-variables-out-of-flash-to-a-server-side-solution-Choose-Three
https://interviewquestionsanswers.org/__What-is-the-advantage-of-progressive-video-download
https://interviewquestionsanswers.org/__Which-statement-concerning-symbol-instance-statements-are-correct-Choose-Two
https://interviewquestionsanswers.org/__What-is-the-function-of-trace
https://interviewquestionsanswers.org/__What-are-the-correct-statements-consenting-text-field-Choose-Two
https://interviewquestionsanswers.org/__What-happens-if-an-swf-is-loaded-into-a-already-occupied-level
https://interviewquestionsanswers.org/


Adobe Flash Interview Questions And Answers

Interview Questions Answers.ORG

Ans:
A. 0
B. -0
C. 1
D. -1
View All Answers

Question - 111:
How many levels does Flash MX support?

Ans:
A. 20
B. 80
C. 100
D. 1000
View All Answers

Question - 112:
If the oilpump movie clip instance in path _root.car.engine.oilpump.clamp uses the following line of actionscript, _parent.someAction;, which movie clip instance is
being referenced?

Ans:
A. Car
B. Engine
C. Oilpump
D. Clamp
View All Answers

Question - 113:
Which of the following is the recommended character to use to separate target level paths levels?

Ans:
A. / (slash)
B. $ (Dollar sign)
C. _ (underscore)
D. % (percentage sign)
View All Answers

Question - 114:
What is the key purpose of using layers in a timeline?

Ans:
A. To determine when things appear in your movie.
B. To separate assets playing at different .
C. To handle the four button states
D. To organize the stacking order of assets.
View All Answers

Question - 115:
What is the effect on the instances of a symbol if the symbol itself is changed?

Ans:
A. All instances change accordingly.
B. Only future instances change accordingally.
C. Only the current selected instance changes accordingly.
D. Symbols cannot be changed once instance of the symbol have been created.
View All Answers

Question - 116:
What is default frame rate of the time line in frame per second?

Ans:
A. 1
B. 12
C. 24
D. 30
View All Answers

Question - 117:
What is Flash Tweening?

Ans:
Tweening comes from the words "in between".
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With Tweening you can go from one keyframe to another and specify changes in the animation and let the Flash program create the frames in between.
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Question - 118:
How to embed Flash in HTML?

Ans:
After creating a Flash movie you choose File > Save As from the top menu to save your movie. Save the file as "YourFlahFileName.fla". 
To embed the Flash movie you just made into an HTML page, you should go back to your Flash program and do the following steps:
Step 1
Choose File > Open. Open a Flash movie you have created.
Step 2
Choose File > Export Movie.
Step 3
Name the file "YourFlahFileName.swf". Choose the location where the file is to be stored (in your Web folder). Click OK.
Step 4
Open the HTML page where you want to insert your Flash movie. Insert this code:
<object width="550" height="400">
<param name="movie" value="YourFlahFileName.swf">
<embed src="YourFlahFileName.swf" width="550" height="400">
</embed>
</object>
View All Answers

Question - 119:
Where to Start the Adobe Flash?

Ans:
After you have installed Flash at your computer, you should go through the flash help that are included in the program. Start Adobe Flash, click Help in the menu and
choose Lessons. 
These lessons will teach you the basics of Flash.
View All Answers

Question - 120:
Who can Create Flash Movies?

Ans:
To create your own Flash movies you have to buy a Flash program from Adobe.
The latest version from Adobe is Adobe Flash Lite (or Flash CS3 Pro).
If you do not have a Flash program, you can download a 30 days free trial version of Flash from Adobe.
View All Answers

Question - 121:
Who can View Flash?

Ans:
In September 2000, NPD Research, the parent company of MediaMetrix, conducted a study to determine what percentage of Web browsers have Flash preinstalled.
The results show that 96.4% of Web users can experience Macromedia Flash content without having to download and install a player.
If you do not have the Shockwave Player installed you can download flash player for free from Adobe's site.
View All Answers

Question - 122:
Explain the Flash vs. Animated Images and Java Applets?

Ans:
Animated images and Java applets are often used to create dynamic effects on Web pages.
The advantages of Flash are as under:
* Adobe Flash loads much faster than animated images
* Flash allows interactivity, animated images do not
* Flash does not require programming skills, java applets do
View All Answers

Question - 123:
Can some organizations block Flash movies from being received through the Internet?

Ans:
While this is partly motivated by fears of Flash viruses and Flash hackers, the greater motivation is disciplining staff. Many managers of private companies do not
want their employees playing Flash games at their office computers, so they will ban Flash movies at work through technical blockers on the network. Do not be
surprised if your employer chooses to implement a ban of Flash at your office.
View All Answers

Question - 124:
Is everyone required Flash Player plugin?
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Ans:
No because they do not like "blinking things" on their screens, some users choose to disable or not install Flash Player.
View All Answers

Question - 125:
If We set slow sync as you suggest in answers on the many online forums you visit, would not we be opening ourselves up to blurred shots when the shutter speed
gets significantly below 1/60?

Ans:
Yes and no. When you shoot with flash, there are two exposures going on: the flash exposure on the subject and the background exposure. If flash is the main source
of light, a stationary subject lit by it should always be sharp, as the slowest Nikon flash duration is about 1/830 of a second. The background, however, very well may
go soft or get blurred by poor handholding technique or subject movement. Many photographers have learned to use this to their advantage--there's one style of flash
that uses very long shutter speeds and panning/zooming/tilting to purposefully blur the background yet still use the flash to "freeze" the subject.
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Question - 126:
I shoot underwater with a TTL strobe that does not allow you to set flash exposure compensation. How do I set fill flash with this set up?

Ans:
Let's assume that you have an N80 body in an underwater case and are using underwater TTL strobes. Here you could set flash exposure compensation from the N80
body (assuming the case let you access that control). I'd tend to set the N80 to Standard TTL if I wanted to fiddle with flash levels, though, as in balanced fill-flash
modes you don't know what compensation the camera is already adding (i.e., you'll only get repeatable results with Standard TTL).
View All Answers

Question - 127:
It seems that most recommendations for using fill flash talk about using -1.3 to -1.7 stops of flash compensation. This seems like very little flash (compared to the
ambient exposure). Would not -.5 or -1 stop be better?

Ans:
Most nature and scenic professionals use -1.3 to -1.7 stops for their fill flash setting because they are trying to do one thing only: increase shadow detail (an alternate
way of saying this: decrease overall scene contrast). Why? Because exposures for slide film need to be biased to the brightest object in the scene (i.e., overexposure of
slide film is VERY bad). Since film has a limited dynamic range it can record with reasonable detail, if you set your exposure to put the highlight at the white point,
you often lose shadow detail. The purpose of the fill flash, therefore, is to raise the film's response curve at the shadow point without further blowing out the detail.
The -1.3 to -1.7 values are often just enough to pull another "stop" of useful shadow detail into an exposure without adding unduly to the highlight exposure. Films
like Velvia are especially troublesome,
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Question - 128:
You understand from the SB-25 manual that the built-in, retractable bounce card is meant for use with the flash head in a vertical position?

Ans:
I do (this is true of the SB-24, SB-25, SB-26, SB-28/28DX, SB-80DX). That's because it helps keep a little light from being lost, but more importantly, it provides
just a bit of catchlight in the subject's eyes (the bounce directly off the card).
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Question - 129:
The F601/N6006 had a special control to set the fill-flash option on the body; Is there a similar way to set fill levels on the F90x/N90s and SB-28 combo?

Ans:
If you're using an SB-24 or later and a modern Nikon body that doesn't have a built-in flash, you set fill levels on the flash. With your combo, you can set fill by
pressing the Minus button on the SB-28 three to five times (-1.0 to -1.7 stops). However, there's a caveat. If you have the camera set to Program (P) exposure mode
and the flash to TTL, you're in what is known as a "balanced" mode. In balanced modes, the camera tries to equalize the flash and ambient light levels. But, when
everything is on automatic, the camera can only set shutter speeds of 1/60 to 1/250, which might not let the camera set the proper ambient exposure. In dim light, for
example, the camera would underexpose the background (though the subject would be lit by the flash). Thus, if you dial in fill flash in this situation, both the ambient
light and the flash would be underexposed, ruining your shot. So, the caveat is this: don't set fill flash levels on your SB-28 unless you know that the ambient
exposure is going to be correct. For dim light, that may mean you need to set Slow or Rear flash sync; in bright light, that may mean you need to set High Speed (FP)
flash sync.
View All Answers

Question - 130:
I shoot underwater with a TTL strobe that does not allow you to set flash exposure compensation. How do I set fill flash with this set up?

Ans:
Let's assume that you have an N80 body in an underwater case and are using underwater TTL strobes. Here you could set flash exposure compensation from the N80
body (assuming the case let you access that control). I'd tend to set the N80 to Standard TTL if I wanted to fiddle with flash levels, though, as in balanced fill-flash
modes you don't know what compensation the camera is already adding (i.e., you'll only get repeatable results with Standard TTL).
View All Answers

Question - 131:
Can Flash .swf movies be very time consuming to edit?

Ans:
Yes It is very laborious work to change a Flash web page quickly. For this reason, you will almost never see a dynamic content page like a news site utilizing Flash

Copyright © https://InterviewQuestionsAnswers.org Page 21/23

https://interviewquestionsanswers.org/
https://interviewquestionsanswers.org/_Adobe-Flash
https://interviewquestionsanswers.org/__Is-everyone-required-Flash-Player-plugin
https://interviewquestionsanswers.org/__If-We-set-slow-sync-as-you-suggest-in-answers-on-the-many-online-forums-you-visit-would-not-we-be-opening-ourselves-up-to-blurred-shots-when-the-shut
https://interviewquestionsanswers.org/__We-shoot-underwater-with-a-TTL-strobe-that-does-not-allow-you-to-set-flash-exposure-compensation
https://interviewquestionsanswers.org/__It-seems-that-most-recommendations-for-using-fill-flash-talk-about
https://interviewquestionsanswers.org/__You-understand-from-the-SB-25-manual-that-the-built-in
https://interviewquestionsanswers.org/__The-F601-N6006-had-a-special-control-to-set-the-fill-flash-option-on-the-body
https://interviewquestionsanswers.org/__I-shoot-underwater-with-a-TTL-strobe-that-does-not-allow-you-to-set-flash-exposure-compensation
https://interviewquestionsanswers.org/


Adobe Flash Interview Questions And Answers

Interview Questions Answers.ORG

for its rapidly-changing content. Instead, Flash is used more for decorative purposes, and for advertising and online gaming purposes.
View All Answers

Question - 132:
What is vector graphic animation?

Ans:
Vector graphics" are different from "raster graphics" like jpg, gif, png, bmp graphics. And vector graphics use math formulas to draw animation shapes, while raster
graphics save millions of tiny colored dots to draw photos.
View All Answers
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